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Welcome to 2015 Knowledge-Based™ Preparations, Compilations and Reviews for Knowledge Coach

This Release Notes document provides important information about the 2015 release of Knowledge Based™ Preparations, Compilations
and Reviews. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998, option
4, then option 1. Additional information is available on CCH Support Online.

New in this Release

2015 Knowledge-Based™ Preparations, Compilations and Reviews is designed to help the accountant efficiently and effectively perform
financial statement preparation engagements, compilations and reviews of nonpublic commercial entities in accordance with
Statements on Standards for Accounting and Review Services (SSARS) issued by the Accounting and Review Services Committee
(ARSC) of the American Institute of Certified Public Accountants (AICPA).

The Knowledge-Based Preparations, Compilations and Reviews (KBPCR) Methodology emphasizes using knowledge of the entity to
perform preparation, compilation and review engagements by facilitating the flow of information so that the understanding obtained in
each process affects the decisions made in the next. Although the accountant will likely perform most steps in this methodology
sequentially, conducting an engagement is not necessarily a linear process. Knowledge gained from preliminary engagement activities
helps the accountant design and customize engagement procedures; evidence gained from procedures performed is evaluated and the
appropriate accountant’s report is issued. This edition includes specific up-to-date guidance for conducting preparation, compilation
and review engagements in accordance with the SSARS. This document is published for the purpose of communicating, to users of the
toolset, updates and enhancements included in the current version. This document is not, and should not be used as, a program to
update the engagement documentation of an engagement started in a previous version of this product.

This document is published for the purpose of communicating, to users of the toolset, updates and enhancements included in the
current version. This document is not, and should not be used as an audit program to update the audit documentation of an
engagement started in a previous version of this product.

This is the fifth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2015 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2015 Knowledge-Based Preparation, Compilation and Review Engagements include the following features:

¢ New Knowledge-Based Preparation Title package to address the requirements of SSARS No. 21 to enable the practitioner to
perform an efficient preparation engagement in compliance with standards including the following new documents:

e  PRP-101 Overall Preparation Program

e  PRP-201 Pre-Preparation Program: Procedures Performed Prior to a Preparation Engagement
e  PRP-202 Preparation Program: Additional Procedures for Initial Year of Engagement

e  PRP-801 Preparation Program: Significant Risks and Uncertainties

e  PRP-901 Preparation Program: Discovery of Facts after the Completion of the Engagement

e PRP-902 Preparation Program: Going Concern

e  KBP-101 Preparation: Significant Matters

e  KBP-201 Preparation: Client/Engagement Acceptance and Continuance Form

e KBP-901 Preparation: Documentation Checklist


http://support.cch.com/productsupport/

e  KBP-902 Preparation: Review and Approval Checklist
e RPT-0999 Disclaimer to Accompany Prepared Financial Statements
e COR-203 Engagement Letter: Preparation of Financial Statements

The Compilation and Review workpapers have been modified to address the requirements of SSARS No. 21 including new and modified
practice points, procedure steps and reports

For more information on specific program enhancements, review the 2015 Preparations, Compilations and Reviews Overview for
Knowledge Coach users available at the following link or in the binder through the KCO-001 workpaper.

https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20Prep%20Comp%20Rev%20Title%200verview%20for%

20Knowledge%20Coach%20Users.pdf

Additional Information on Knowledge Coach and the KBA Methodology

The key components of the KBPCR methodology include:

An Overview that guides accountants through the KBPCR methodology;

Preparation Programs, Compilation Programs and Review Programs that take accountants through related steps and procedures
designed for use in compilation and review engagements;

Practice Aids to help accountants complete steps or processes outlined in other related documents and provide example
financial statement formats for different types of entities;

Reports that provide a variety of sample accountant’s reports on compiled or reviewed financial statements;
Correspondence documents that provide sample engagement letters and management representation letters to be used in
many common situations; and

Knowledge-Based Preparation, Compilation and Review documents, integral to the overall engagement process, that contain
steps and procedures required by SSARSs.

The AICPA’s Accounting and Review Services Committee (ARSC) SSARS - The practice aids and tools in the 2015 Edition of Knowledge-
Based Preparations, Compilations and Reviews are designed around the AICPA’s SSARS standards to assist accountants by:

¢
¢
¢

Facilitating compliance with the SSARS;
Encouraging more effective engagements through tailored engagement programs and comprehensive practice aids; and
Enhancing engagement documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows accountants to use the Knowledge-Based methodology more efficiently
by eliminating the need for duplicate entry of the same information, tailoring documentation to each particular engagement,
and documenting procedures performed. PRP-100 Tailoring Question Workpaper, CMP-100 Tailoring Question Workpaper or
REV-100 Tailoring Question Workpaper are documents in Knowledge Coach that presents engagement-level questions designed
to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the accountant avoid
duplication and unnecessary workpapers.

Before you begin your engagement, please review the guidance in PRP-101 Overall Preparation Program, CMP-101 Overall
Compilation Program or REV-101 Overall Review Program. These workpapers are intended to be your road map through the
Knowledge-Based methodology. You should start your engagement with PRP-100 Tailoring Question Workpaper, CMP-100
Tailoring Question Workpaper or REV-100 Tailoring Question Workpaper and PRP-101 Overall Preparation Program, CMP-101
Overall Compilation Program or REV-101 Overall Review.

The Risk Assessment features have been disabled since the 2012 Knowledge-Based Compilations and Review Title for Knowledge
Coach.
e Referto:

" KBP-101 Preparation: Significant Matters, KBC-101 Compilation: Significant Matters and KBR-102 Review:
Significant Matters to accumulate and review significant issues and findings.

" PRP-801 Preparation Program, CMP-801 Compilation Program: Significant Risks and Uncertainties and REV-802
Review Program: Significant Risks and Uncertainties provides a guide for implementing the guidance related to the
disclosure of certain significant risks and uncertainties.


https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20Prep%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf
https://support.cch.com/updates/KnowledgeCoach/pdf/guides_tab/2015%20Prep%20Comp%20Rev%20Title%20Overview%20for%20Knowledge%20Coach%20Users.pdf

¢ Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the engagement file.

¢ Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

¢ Reference to Accounting Research Manager (ARM) - If you subscribe to an ARM library that includes preparation, compilation
and review content, you can link directly to source material from Resources within Knowledge Coach documents. These links
have been updated to refer to the accounting standards under the FASB Accounting Standards Codifications. Also, if you
subscribe to the Knowledge-Based Preparation, Compilation and Review Guide on ARM, you can take advantage of references to
the guide material from within the Knowledge Coach documents.

¢ The references in the 2015 Knowledge Coach workpapers are manual because the updated 2015 Guide on ARM is not yet
available, as of the publication date for the Knowledge Coach title. Please refer to RES-001 Knowledge-Based Preparation,
Compilation, and Review Methodology Overview for a comprehensive guide material for these engagement types.

¢ Interpretive Guidance is integrated into each Knowledge Coach through the Tips view of each new task pane. Informational
features include Practice Points, Examples, Optional Workpapers, and Resources to help accountants work more effectively and
efficiently. We have also added the ability to navigate from Resources within a document or the tip pane directly to CCH’s
Accounting Research Manager and industry audit guides by simply clicking on the Reference.

Important Notes

Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.
If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
Keep the binder with the affected workpapers open.

Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.

®* & & oo o

Knowledge Coach cannot be used within the Shared File Room (SFR) feature of Engagement. However, Knowledge Coach
workpapers can be shared across team members through check in, check out, workpaper assignment, syncing to the central file
room and through peer-to-peer sync in the same way other Engagement workpapers are shared.

System Requirements

¢ This title MUST be used with ProSystem fx ® Engagement version 7.1, ProSystem fx® Knowledge Coach version 2.1, and 2014
Financial Statement Base v4 and higher. If you are upgrading from ProSystem fx® Engagement 7.0 or lower please contact
Technical Support at 1-800-PFX-9998, option 4 for detailed instructions.

¢ A minimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2015 Knowledge-Based Preparations and/or the 2015 Knowledge-Based Compilations and/or 2015 Knowledge-Based
Reviews from the ProSystem fx ®Knowledge Coach Updates section of the ProSystem fx® Engagement Support Web site at the
following URL: http://support.cch.com/updates/KnowledgeCoach, then select the Knowledge Coach Series and Download file link next
to the 2015 Knowledge-Based Preparations, and/or 2015 Knowledge-Based Compilations, and/or the 2015 Knowledge-Based Reviews
titles. On some occasions the content package file (KCP) will download with the extension changed to .ZIP. If this occurs, please change
the extension of the downloaded file to KCP using all capital letters.

You must install the 2014 Financial Statement Base v4 title before installing the 2015 Knowledge-Based Preparations, 2015 Knowledge-
Based Compilations and 2015 Knowledge-Based Reviews.

The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

If you have already installed this title for 2014 Knowledge-Based Audits of Commercial Entities, ensure you have the latest Knowledge
Coach Content Update installed.

Important: ProSystem fx® Engagement version 7.1 or higher and Knowledge Coach version 2.1 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2007, Microsoft® Office 2007 Primary
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Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The following 2015 Knowledge-Based Preparations, Compilations and Reviews (6/9/15). KCP download is a proprietary file that must be
installed from within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in
the Release Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2015 Knowledge-Based Preparation, Compilations and Reviews titles, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Once the title is added, you must release it, so that other staff members in your firm can use it. You may also wish to “unrelease”
previous versions of the title.

To unrelease a title:
¢ Select a version of the KBA Preparations, Compilations and Reviews titles.
¢ Choose Unrelease Title. The date will be removed from the Date released column and staff that do not have the staff group
property right to insert unreleased titles will not be able to insert the unreleased titles into a binder.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.
¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2015 Knowledge-Based Preparations, Compilations and Reviews titles have been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.1 and higher. After
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updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2015
Knowledge-Based Preparation, Compilations and Reviews.

If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.
Permission keys are no longer generally distributed via floppy diskette. You can choose to continue receiving the diskette by going to

https://prosystemfxsupport.tax.cchgroup.com/service/accountadmin/ , clicking the Firm Administration link, and making the
appropriate selection (SSO access is required), or by contacting Customer Service at 1-800-PFX-9998, option 4.

Accounting Research Manager

CCH'’s Accounting Research Manager is the most comprehensive, up-to-date and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written
interpretive guidance.

Our Weekly Summary email newsletter highlights the key developments of the week, giving you assurance that you have the most
current information. It provides links to new FASB, AICPA, SEC, EITF, and IASB authoritative and proposal-stage literature, plus guidance
from financial reporting experts.

Our team of content experts updates the system on a daily basis, so you can stay as current as possible. What’s more, our experts
attend critical, standard-setting meetings and summarize the results for you, which means you'll learn of newly released literature and
deliberations of current financial reporting projects as soon as they occur! Plus, you'll benefit from their easy-to-understand technical
translations. Our expert’s interpretations clearly lay out what the rules mean from your perspective.

Also available in the Knowledge-Based Preparations, Compilations and Reviews title, a guide that helps you comply with the most
recent professional standards and guidance for the conduct of compilations and reviews and to integrate the use of practice aids, tools,
and other resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are
available in Knowledge Coach.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the
Shortcuts bar in the Binder window.

Reference to Accounting Research Manager (ARM) — If you subscribe to an ARM library that includes preparation, compilation and
review content, you can link directly to source material from Resources within Knowledge Coach documents. These links have been
updated to refer to the accounting standards under the FASB Accounting Standards Codifications. Also, if you subscribe to the
Knowledge-Based Preparation, Compilation and Review Guide on ARM, you can take advantage of references to the guide material
from within the Knowledge Coach documents.

Note: The references in the 2015 Knowledge Coach workpapers are manual because the updated 2015 Guide on ARM is not yet
available, as of the publication date for the Knowledge Coach title. Please refer to RES-001 Knowledge-Based Preparation, Compilation,
and Review Methodology Overview for a comprehensive guide material for these engagement types.
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Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a
binder in ProSystem fx® Engagement, select the workpaper tab
into which you would like to insert the workpaper, and select
New Knowledge Coach Workpaper from the toolbar or File
menu. The New Knowledge Coach Workpaper dialog appears
(Figure 1).

Select the New Knowledge Coach Title with the content you
would like to use. You can only select titles you have installed.
The information displayed changes to reflect the workpaper
organization available for the selected title. Select the
Knowledge Coach Workpaper Templates to insert into your
binder and click OK. The Selected Workpaper Properties dialog
appears. Each workpaper name is automatically loaded into the
Name field. Add a workpaper index in the Index field and make
any Name modifications you desire. You can also modify the tab
location or the roll forward settings for each workpaper. Then
click OK. The integrated Knowledge Coach workpaper is now
inserted into your engagement binder. For more information on
how to use Knowledge Coach workpapers in your binder, see the
Knowledge Coach User Guide.

New Knowledge Coach Warkpaper “

Industry:| 2015 KBA Compilations Y] ‘,Tg _Tg
[[] Show independent workpapers only

] 000-Resources Details of selected workpaper
] 100-The Communications Hub
200-Pre-Engagement Procedures

+ B00-Compilation Procedures

-]  900-Evaluating, Concluding & Reporting Procedurss
Highlight a workpaper or select
a workpaper check box to see
details.

Cancel Help

Figure 1 - New Knowledge Coach Workpaper

2015 Knowledge-Based Preparations, Compilations and

Engagement v. 7.1 with Knowledge Coach 2.1 or higher and

Download

Description: Reviews Title(6/5/2015)

Version: 2014 Financial Statement Base v4
Release Date: June 2015

File size: 18MB

Approx. Download
Time:

License: Full Version
Platforms:

Office:

Contact Information

42 minutes at 56 kbps

Windows® Vista® 7, 8 and 8.1

Microsoft® Office 2007 required

¢ For ademo or to purchase additional titles as they become available

1-800-PFX-9998, option 1



¢ Technical Support 1-800-PFX-9998, option 4, then option 1

The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.
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